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ПОДПИСАТЬСЯ Page 2 WHEN IT IS LOCATED IN THE Audacity Development Manual Click on the image to learn more Links: Most of the links are to other pages in this manual. Italiciszed links are to pages outside this Manual, mainly on our main website or Wiki. We are not responsible for the content of any other external site. Screenshots: Most
screenshots of this manual are of Audacity running under its default settings in Microsoft Windows 10® operating system. Copyright: The pages in this manual are available under the terms of the Creative Commons Attribution 3.0 license. In essence, you are free to (1) copy, distribute and transmit the work (2) to adapt the work, on the condition that you must
attribute the work to the authors (but not in any way that suggests that you endorse it or your use of the work). For any reuse or distribution, you cannot delete our copyright notice and must make the license terms for this work clear to others. From the Audacity Development Manual This page lists tutorials that provide step-by-step instructions for performing
common tasks in Audacity. How to import an audio file into Audacity (for example, an MP3 music file), edit it and export the result. Detailed instructions for connecting the audio source (be it a microphone, guitar or keyboard) to your computer, and then recording that source with Audacity. Mixing voice with background music How to edit a narration to suit the
rhythm of background music, and fading music so listeners can hear their storytelling, useful in particular for podcasts. Multi-track overdub recording A set of tutorials on making multi-track recordings, using three different specialized audio interfaces or using the sound card on board the computer. Punch-in repair recording sponge simple instructions on how
to repair a short fluff recording: a spoken wrong word, an obvious breathing sound or a cough say. Vocal techniques of removal and isolation that in some stereo tracks can allow to eliminate or isolate the voices (or other parts of a recording) from the rest. How to make an audio loop with Audacity. Make ringtones and IVR nessages How to make ringtones for
your mobile phone or messages for your IVR system with Audacity. Recording audio playback in real time on your computer How to record the audio being played on your computer, such as streaming audio from Internet websites. Copy tapes, LPs and other media to CD or computer Detailed instructions on connecting your rotating table, tape cover or
MiniDisc player to your computer, recording from this device, and then editing and exporting so you have separate audio files for each original source song ready to burn to a CD or import to a media player like Apple Music/iTunes. Click and pop removal techniques The main audacity tool to deal with clicks and pops is the Click Removal effect. Clicks that
don't Removed with Click Removal can be dealt individually with other methods. These methods are only really useful if you have a relatively small number of clicks and it appears to deal with; otherwise, these approaches will be too labor intensive and time-free. Split a recording into separate tracks using Tags How to split a recording into separate songs for
export in preparation for recording these tracks to an audio CD or charging into a portable player. Audacity does not burn CDs directly but audio files created with Audacity can be used with a CD burning application to create an audio CD. How to import CD audio as WAV or AIFF files for editing in Audacity. Exporting to Apple Music/iTunes How to export
Audacity audio files for use in Apple Music/iTunes Importing Apple Music/iTunes How to import Apple Music/iTunes files for use on Audacity Recording Church Services Audacity is an excellent way to capture audio from your weekly service and make MP3 sermon or audio CD. With a simple USB interface, and some knowledge about mixing consoles, the
laptop can be a recording station. The following tutorials provide sample workflows for common tasks using Audacity, there is no fixed way to work properly – there are many alternatives: Sample workflow for LP digitization Sample Workflow for tape digitization Sample Workflow to export to Apple Music/iTunes Audacity is a piece of sound editing software
that is widely known to be open source (for free) and offer cross-platform compatibility. Because it is free, however, there are some drawbacks. In general, Audacity is not as robust and polished as some other professional sound editing programs, and there are some bugs in the software that can cause it to crash unexpectedly. Some of the advantages of
Audacity: Free of charge Compatible with Mac OSX, Windows, Linux and other Lightweight operating systems and a relatively small open source program size with community support working to continuously improve Some of the drawbacks of audacity are: There are several known (and unknown) errors that can make the program become unstable The
program is limited in its mixing capabilities Some aspects are more complex, and not so easy to use The program is not so complete, since you will need to install plug-ins/encoders separately Audacity can be downloaded to the following location: (This tutorial was written using Audacity for mac OSX version 1.3.6 in November 2008. While the screenshots
and some menu items are Mac-specific, to attend to all platforms. Due to Audacity's open source nature, the program tends to be updated regularly, and some information may become obsolete. We'll try to keep it updated where possible.) Download, install and configure Download and install Audacity Audacity While software manufacturers allow users to
download the latest beta versions of the program, doing so may have some unexpected consequences. Generally beta software is still in test mode and could be unstable. If you work on production material, users are suggested to download stable versions until beta versions replace them. This tutorial was written using the latest beta version, however, to
keep it as up-to-date as possible. Download and install MP3 encoder While the MP3 encoder is listed as an optional download, it is required to export MP3 files. MP3 files are ubiquitous on the web, and their small size with relatively low quality loss ensures that it will be fast and easy to download. Installing an MP3 encoder is highly recommended. The MP3
code uses audacity is called LAME. Despite its name, LAME is an open source MP3 encoder that allows many software applications to create MP3 from uns compressed audio files. LAME is a reverse acronym for LAME ain't a MP3 encoder, which is misleading because it is an MP3 encoder. The name was a reference to the early version of the software.
From the downloads page of the Audacity website, you'll see some optional downloads. Click the link for the MP3 LAME encoder, or follow this link: LAME MP3 Encoder. Follow the instructions to download the LAME MP3 Encoder package to your computer. Once you have extracted the package, open Audacity, and select Preferences under the Audacity
menu (Mac) or Edit Menu (PC). From the menu on the left, click Import/Export (it can be labeled differently in earlier versions of Audacity), and then click the Find Library button. If you didn't download the LAME library yet, there is also a download button to do this here too. Use Browse... button to find the location of the LAME package file, either
libmp3lame.dylib (Mac) or lame_enc.dll (PC). Click OK. Workspace Let's take a look at the Audacity workspace. At the top are several buttons that allow you to play, stop, pause, fast forward, rewind, or record a track. To the right of this are some playback and logging measurers that display sound levels. Since the volume at which you hear your sound may
vary depending on how you load your speakers or headphones, these counters are important as a visual way to determine the overall levels of your sound. Then (or to the right, depending on the width of the window) there are some play speed adjustment sliders. This is generally not used in most sound editing, but could be useful for transcribing dictation.
Be careful that this setting is not changed before audio file. The audacity also comes with an UNDO button. This feature is critical to undoing errors. Each time this button is pressed, the last previous actions are reversed in the order in which they occurred. So pressing the undo button five times undo the five previous actions. Respectively, there is a redo
button that will take an action again if you have already undone several steps. As with most software these days, the shortcut key to undo is Ctrl-Z (PC) or Command-Z (Mac). Tools in Audacity Audacity has six tools to choose from. The selected tool will determine how the cursor interacts with the audio track. Always note which tool is currently selected, as it
will affect each click on the audio track. This is the main selection tool that allows you to highlight parts of a track to copy or paste. This is the envelope tool, which allows you to change the volume of certain portions of your audio track by visually reducing it. You can use the tool to place anchor points around the track to guide the sound level. The Audacity
drawing tool is probably one of the least used tools. It has to be extended very close to the audio file, so much so that you can see each individual sample of the file (usually 44,100 per second). The drawing tool allows you to edit each of these samples, which will appear as anchor points of the file. This can be a tedious process, but possibly useful when it
comes to editing a spurious noise as a click. The zoom tool simply zooms in on or off the track. To move away, right-click (PC) or click the (Mac) control on the track. You can also click the vertical ruler at the front of the track to vertically enlarge the track. Where you click on the ruler will determine which part of the track will expand. The time change tool is
used to move audio segments within a track. To split a track, you must first use the selection tool, and then choose Split from the edit menu (new versions of Audacity only). The Audacity multi-tool may be one of the most useful tools, or one of the most confusing tools in the program. Essentially, the tool is a combination of selection tools, about and time
change, and its functionality is determined by which part of the track you click, and the moves used to drag portions of the track. Basic audio editing audio import As a general rule of thumb, you just need to import uncompressed audio into any sound editing program. This means that you should import .wav, .aiff, or other lossless file type. While it's technically
possible to import compressed audio as MP3 files, you're likely to see a decrease in quality as you repurchase it in export. Each time a file is compressed, it loses some quality, similar to making a copy on a copy machine. Recompressing is analogous to making a copy of a copy. To import audio, click the File menu, and then select Import -&gt; Audio. Once
You can use the SPACEBAR to play the audio file or press the green play button at the top. Using the Selection tool to edit audio Use the selection tool to jump to various points on the track, or or and drag to select a part of the track. If you move the cursor to the very edge of a selection, a small hand with one finger appears. This allows you to resize the
current selection. You can press the delete key on your keyboard to remove a highlighted part of a track. Or you can use the standard copy, cut, and paste key combination to scroll through audio segments. Every time you remove a portion of the track, Audacity automatically slides the audio immediately after selection to fill in the remaining gap. If you don't
want this to happen, use Split Remove from the Edit menu. When split delete is used, a gap is left in the audio track that will be heard as silence. Split Delete only works with highlighted audio portions. If you want to simply split a track in half without selecting it first, use the Split under the Edit menu. You can use the time change tool to move each tile along
the track independently. Moving an audio block to the other side of another segment is technically possible, but it can be difficult to do. The first option is simply to drag it to the other side, but for it to work it must have enough space to accommodate the block on the other side. Also, you should be able to see the other side of the view. If you can't, you may
need to walk away. The other option is to copy and paste the block using the selection tool. Zooming in and out of Audacity offers several different methods for manipulating the viewable workspace. We'll start with the zoom tool. Horizontal zoom Using the zoom tool, simply click on the track to expand it horizontally. To zoom out, simply right-click on the track
using the zoom tool or hold down SHIFT to change the zoom tool to a zoom tool. Vertical zoom To zoom the track vertically, you must click on the front of the track where the amplitude measurements are displayed. But here's the trick: where you click the ruler will determine which part of the track will expand. Clicking at the top of the ruler will zoom vertically
to the top of the track. Clicking at the bottom of the ruler will enlarge the bottom of the track. To zoom out, follow the same steps as horizontal zoom: Right-click the ruler or hold down SHIFT and click the ruler. (Note: Boldness facilitates vertical zooming, allowing you to click on the ruler with any tool. The same effect will occur. You don't need to be in the zoom
tool to cause it.) Stretching the track size You can easily resize the track itself by moving the mouse over the bottom edge of the track and dragging it down. Using the About Tool Envelope is used to lower the volume at a specific point in the audio track. This is useful for effects such as fading and fading. Select the tool above the toolbar and you will see a
blue line appearing around the track. The cursor will be changed into two small white arrows pointing up and down. This specifies the region where you can place an anchor point on the edge of the track. Click and drag the wave shape border to the center. Click on other wave shape areas to place white anchor points. Wave-shaped parts that are smaller, will
play the sound quieter than the parts that are larger. The wave shape will be reduced in certain areas giving a visual representation of how the sound is adjusting. Adjusting audio sound levels this way does not affect quality, only volume. While it may seem like you are affecting the quality of the wave shape, rest a sure that this visual representation is only
affecting loudness. To make a fade, drag the white anchor points to the center. A curve will be formed that allows you to create fade-outs. To remove the anchor points, drag them left or right until combined with another set or drag completely off the track. Selecting another tool will turn off the envelope function. A light gray color will still appear in the
background as a visual sign of how the track was affected. Adding tags to identify audio segments When working with any audio program, you need to mark audio areas to help you identify different segments of your tracking. Editing audio visually using an ambiguous wave shape can be difficult, especially with longer audio tracks. Boldness, like many audio
programs, includes a mechanism to tag different areas of the audio track and use these markers to help you edit. To tag a specific area of the audio track, first click the part of the track you want to tag with the selection tool, and then select the Tracks menu and select Add Tag to Selection or Ctrl-B (PC) Command-B (Mac). A new special tag track will be
created if you don't already have tag tracking. Type a name for the label you just created. Labels should describe this part of the track. Keep it short, so you can add multiple labels. Adding multiple tags also helps you in the editing process by marking specific segments and allowing you to select them. Tags should not only mark a single point, they can mark
an audio range with bookmarks called limits. To expand a tag to include an audio range, roll the mouse over the label to highlight it first, and then click and drag the boundary to the left. Dragging to the left will open the tag to include an audio range, but dragging the limit to the right will close the extension or move the on the right. This period can be used to
help you edit your audio. Click one of the boundaries with the selection tool and drag the selection to the other boundary. You can do this on the audio track or tag layer. If you highlight the audio, audio, you will use the limits as guides to select your audio. If you highlight the part in the tag layer (as shown below) you can use some special label features to
modify the audio. Under the Edit menu, you'll find the For Tagged Regions option. These belong to regions of the layer of labels that are highlighted. These options will only appear if you have a section of the label layer highlighted. There are many other features you can do with labels, such as exporting track segments to separate files using File -&gt;
Multiple Export. But these techniques are out of reach of this tutorial. See the official Audacity Wiki for more information on tags. Filters and cleansing of audio audacity comes pre-packaged with some third-party filters to help manipulate your audio track. One of these tools is a noise desensador filter that can remove sounds like hoistes and hums from your
audio track. The noise remover filter cannot remove different sounds, such as a voice or interrupt, but is intended to reduce constant sounds that affect much of the track. To use the noise removal filter, you must first test a portion of the audio track that only has the noise you want to reduce. Step 1) Highlight a part of the track that only has the noise. This is
important, or noise removal will test the entire track. Step 2) Under the effect menu select Utility – Noise Removal &gt; – Removal &gt; Noise... (the location may vary depending on the version of Audacity you're using) Step 3) The Noise Removal dialog will describe the two-step process. In this first step, click Get Noise Profile, which will store a sample of
system noise. After clicking Get Noise Profile, the filter will analyze the highlighted part of the track and learn how unwanted noise sounds. Step 4) You need to highlight the portions of the track you want to remove the noise from. Most of the time, this will be your whole track. You can select the entire track by clicking Ctrl-A (pc) or Command-A (mac). Step 5)
Reopen the noise removal tool by clicking Effect –&gt; Utility –&gt; Noise Removal –Noise Removal &gt;'Removal... Play with the sliders at the bottom of the dialog. Remember, despite its name, the noise removal tool only reduces unwanted noise. Adjust the top slider, Noise reduction, to specify the amount of reduction you want. The average slider,
frequency softener, will attempt to retrieve the audio you want at the risk of adding a metallic or empty sound. The attack/decay environment will also help recover some of the desired audio that noise reduction could eliminate. The it's not perfect. Play with the sliders and click the Preview button to show a few seconds of the audio to see how it looks affected.
Once you are happy with the results, click OK to process the track. Track. and Saver for journalistic audio pieces, the typical workflow is to listen to each track first, and then clean it up based on a script or a producer's preferences. This could include removing clicks, pops, slapping, or even portions of the audio track that you know won't become a part of the
final product. After cleaning each track, it is a good practice to export each cleaned file as a .wav or .aiff file not compressed into the project folder. The reason for this is so you have a copy of each edited track that is part of your project. Once you have exported each individual piece of audio, start a new Audacity project and import these non-compressed
files as several tracks to begin the second phase of audio editing that is mixing your different tracks together. The organization plays an important role in complex audio productions, and building best practices will make editing work much easier. Exporting audio tracks Exporting Audio to Audacity is a fairly direct process. From the File menu, you have two
options to export; you can export or export the selection. If you choose Export Selection, you will only export highlighted regions of your audio tracks. This allows you to export only a certain segment of the audio. If segments are not highlighted, Audacity will automatically highlight your entire project. Export will always export the entire project. In the Export
dialog box, you will be given the option to choose the audio format. If you export individual tracks that have been cleaned, it is highly recommended that you export in any . WAV or . Aiff. Both are similar, the difference is that. WAV was made by IBM and is now a standard on windows pcs, and . AIFF was specifically made by Apple. To ensure compatibility, it
is recommended to choose .wav if you are on a PC or .aiff if you are on a Mac. Save your audio files Once you have cleaned and exported each audio track to the main project folder, you can start your final Audacity audio project. Import each track, and along the way, you should save your project to avoid losing any hard work. Audacity only saves on its own
owner format called the Audacity Project (. AUP) From the File menu, click Save As... The first time you save, a warning message may appear making you know that the Audacity file format is not an audio file standard, but a file type that is for Audacity projects only. You can disable this warning from appearing in the future by checking the box. A second
dialog box may also appear asking you about any connected media (this warning will only appear if you have audio tracks imported into your project). What this dialog is asking for is if you want to copy the audio files are part of your project in a special data folder that is close to your Audacity (. AUP) project file. You can copy the selected selected ones In
Project or Copy all audio to the project, but either way it is highly recommended to copy all media connected to your project. and keep it autonomous. Audacity will create a special data folder named after the project name. For example, if your project is named test the folder would appear as test_data. This data folder contains information about your project
and should always be in the same location as your audacity (. AUP) project file. If you want to transfer your project to another computer, you must copy both the .aup project file and this data folder. Remember to save often. Accidents happen! Track Mixing One of the basics of audio editing is the mixing phase. This is where you take several edited individual
tracks and mix them to form a complete audio piece. To start mixing, import two or more audio tracks into your project. You can use the time change tool to move tracks left or right to adjust the timing. In general, the audio tracks are stacked by level of importance or prominence. This means that storytelling or interviews would be at the top; environmental
music or sounds would be below; and finally the sound effects or tone of the room would be at the bottom. You can adjust your order by clicking the drop-down menu at the top of each track. Once you've imported multiple audio tracks, it's important to name each track to help identify what's in them. Click the drop-down menu just to the right of the nearby X
button and select the name. Identifying clues is also important for the times you want to return to an old project. You can use the envelope tool to create fadeouts and adjust the volume of each track relative to others. It is a good practice to bring music and ambient sounds slowly. The aim of the mix is to maintain the inspicuous sound effects so as not to
distract the listener from the primary narrative. Rather, ambient sounds should support narrative by adding dimension to the piece, not dominating it. If you need to listen to only one track temporarily without the distraction of others, you can use the muted and solo buttons that will temporarily close other tracks. Mute will turn off the current track, and solo will
turn off all other tracks except the one that is solo. These are especially useful when mixing large projects with lots of tracks. (Remember to turn all tracks back on before the final export. It's easy to forget about a track that was silenced) Demystifying Stereo and Mono Because of the way Audacity treats individual tracks, it's easy to get confused about the
difference between stereo and mono projects. Firstly, a review of the on the nomenclature in Audacity. Tracks - Tracks are individual pieces of audio. They can be stereo or jumpsuit. Channel : Channels refer to the right (R) or left (L) speaker. Stereo - Stereo refers a track where there are two channels that are clearly different. It will appear as a clue, but with
two wave shapes on it. Mono – Where a single track is distributed to both channels. The confusion comes upon realizing that, in Audacity, each track can be specified in the left channel, right channel, jumpsuit or placed on a stereo pair. The following sections will take you through some different scenarios. To change the mono tracks to generate audio in
mono To change these settings, click the drop-down menu at the top of each track (where the track name is). Most interviews are done with a single mono microphone. In these cases, you almost always want to use the jumpsuit option for each track. Whether from the jumpsuit option on each track will ensure that the audio is evenly distributed against both



channels. If the track is set to the right or left channel, you'll hear it come out on one side during playback. If you notice, set the track to mono. Switching from stereo tracks to mono tracks Some digital audio recorders have stereo microphones and will record two audio tracks as a stereo pair. You will know that you have this situation if you import your audio
and you see a single track, but with two wave shapes, as in the image below. Note that the image above is an audio track, although the track has two different wave shapes. This is called a stereo pair, and each of the wave shapes is in a different channel (the top wave shape is the left channel). You cannot edit these channels individually. The settings you
make will be made to both channels equally, even when you adjust the sound envelope or cut the track during editing. First you have to decide if you want your project to be a stereo project or a mono project. A stereo project may sound a little more realistic because it mimics how sound is interpreted in real life. However, the solid file will be twice as large and
that can cause slow loading speeds on the Internet. The most serious journalistic radio organizations only use mono tracks. Stereo can interfere with the way history is perceived or be a distraction. Although, in some cases, it can also add dimension to a project that puts the listener right there. This choice is subjective, sometimes even ethical. For general
purposes, we recommend making journalistic audio pieces in mono. There are two methods to turn a stereo track into a mono track. Method 1) Split the stereo track and remove one of the channels To split the stereo track, click the drop-down menu on the track and select the split stereo track. This will divide the channels into individual tracks. Once you have
two tracks, you can simply delete the track you don't want by clicking the close button on X. Method 2) Merging the two channels from a stereo track into one track (preferred) you feel you might need audio from both channels, then then you can combine the two channels into one. This could happen if you recorded a team interview, and a person might have
been closer to one side of the recorder and it might sound louder on a channel. The combination of channels ensures that the sounds of both channels are equally represented on the track. To convert, click the track you want to merge, and from the track menu, select Stereo Track in Mono. There could be a slight loss of quality in the combination of the
channels, although if there is, it would only be very slight. Audio Export The last step in audio production with Audacity is exporting your file. To export, click the File menu and select Export or Export Selection. The export selection option will only export highlighted parts of the audio. In the range dialog, you will have the option to choose the audio format and
set additional options based on this format. For Format, we recommend that you choose .mp3 your intention is to put this audio on the web. If you need an uncompressed copy, for example for a presentation and audio file size doesn't matter, we recommend exporting to .wav (PC) or .aiff (mac). Unless there is a specific need, you shouldn't select the other
formats. This tutorial will display the options for selecting .mp3, exporting for the web. After choosing .mp3, click options... button to see additional options for the file format. (Options can only be clicked if you select a format that has additional options.) For bitrate mode, we recommend that you choose Constant, which will produce the best quality. You can
think of bitrate as audio resolution. The higher it is, the crisper and cleaner the sound. Bit rates that are too low will have a metallic or unharmed sound for them. The standard CD quality is 128 kbps, which is what we generally recommend. If it's a sticker on solid quality, you can select 192 kbps for outstanding quality, but the end user could expect slower load
times if you have really long audio tracks. Wait for an hour-long mono audio mp3 file to end around 30 megabytes if exported to 192 kbps. For channel mode, you will have the option to choose stereo set, or just stereo. Stereo set combines certain frequencies of both channels to create a slightly smaller file. If you have a mono project, you have to choose the
joint stereo – as it won't affect anything. If you have a stereo project, it is also recommended to choose joint stereo, unless you specifically need the two channels to be separated. The following dialog box will ask you to type some metadata into what is called the id3 tag. Filling in this information is completely optional, but highly recommended. Most of the
audio, such as iTunes and Window Media Player use this metadata to categorize audio files. Although id3 tags are generally built to support music files, they can useful even for periodic pieces. Longer files may take a while to export, an important fact to consider when they're on deadline. Most of the time you can expect the export to take anywhere from half
to full length of the audio to process. This tutorial was written by Jeremy Rue. Reissring the Policy This content cannot be republished in print or digital form without the express written permission of the Berkeley Advanced Media Institute. See our Content Redistribution Policy. © 2020 The Regents of the University of California, California
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